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Documentation Updates

The title page of this document contains the following identifying information:

®  Software Version number, which indicates the software version.
® Document Release Date, which changes each time the document is updated.
® Software Release Date, which indicates the release date of this version of the software.

To check for recent updates or to verify that you are using the most recent edition of a document, go to: http://h20230.www2.hp.com/selfsolve/manuals
This site requires that you register for an HP Passport and sign in. To register for an HP Passport ID, go to: http://h20229.www2.hp.com/passport-registration.html
Or click the New users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product support service. Contact your HP sales representative for details.

Support

Visit the HP Software Support Online web site at: http://www.hp.com/go/hpsoftwaresupport
This web site provides contact information and details about the products, services, and support that HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and efficient way to access interactive technical support tools needed to manage
your business. As a valued support customer, you can benefit by using the support web site to:

®  Search for knowledge documents of interest

Submit and track support cases and enhancement requests

Download software patches

Manage support contracts

Look up HP support contacts

Review information about available services

Enter into discussions with other software customers

Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also require a support contract. To register for an HP Passport ID, go to:
http://h20229.www2.hp.com/passport-registration.html

To find more information about access levels, go to:
http://h20230.www2.hp.com/new_access_levels.jsp

HP Software Solutions Now accesses the HPSW Solution and Integration Portal Web site. This site enables you to explore HP Product Solutions to meet your
business needs, includes a full list of Integrations between HP Products, as well as a listing of ITIL Processes. The URL for this Web site is
http://h20230.www2.hp.com/sc/solutions/index.jsp
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What's New in UFT 12.00?

Congratulations! You are now ready to use UFT 12.00.

This document provides an overview of the features and environment support capabilities that were
introduced or enhanced since the UFT 11.50 release.

See the sections below to learn more about the new functionality and support available in UFT
12.00. Each section covers the changes in overall UFT as well as changes that affect GUI Testing
or API Testing.
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New Features

Learn about the new features in UFT:

New Features in UFT 12.00

Learn about the new features that were added to UFT in version 12.00.

UFT Installation: Faster, Smaller, and More Secure

UFT 12.00 delivers a new installation package, enabling you to install UFT more quickly and with
greater security:

The size of the installation package is significantly smaller than in previous releases, speeding
up the installation time.

You caninstall UFT from a DVD or from a Web download package.

You can choose to install the UFT Add-in for ALM and the Run Results Viewer as part of the
UFT installation.

The installation process includes all of the configurations needed to run UFT. You no longer have
to run additional post-installation programs.

The installation is more secure, enabling you to install UFT without needing to temporarily
disable the User Account Control (UAC) for your computer.

You can now install UFT in any supported language without the need to install a separate
language pack in addition to the UFT product installation.

You can also perform a single silent installation without the need to run additional installations,
including the following features:

All installation prerequisites can be installed with a single command (without the need to install
each separately)

All add-ins (including the ALM Add-in for UFT) installed with a single silent installation command
and without the need to restart

All UFT configurations can be added to the silent installation commands

The silent installation can be run without administrator permissions.

You can also find specific guidelines for large-scale enterprise deployment across your
organization's computers, including best practices and security guidelines.

CQD Learn more: See the HP Unified Functional Testing Installation Guide.
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Run GUI Tests on Safari on a Remote Mac Computer

You can now run tests on Web applications on a Safari browser that is running on a remote Mac
computer.

Note: This feature is provided at Technology Preview level.

After you install the UFT Connection Agent (provided with the UFT installation) on your remote Mac
computer, UFT can connect to the Mac computer remotely and run Web steps on the Safari
browser.

Note that you must design the tests locally using a supported (Windows) browser, and that you can
only run Web test object steps on the Safari browser. All other steps, including Utility object steps,
such as SystemUtil.Run, run locally on the UFT computer.

Conditionally Upload Run Results to ALM After a Run
Session

Your ALM site administrator can now set a site parameter that instructs UFT to conditionally upload
run results from a run session to ALM. You can set the parameter so that the results are always
uploaded, or you can use site parameter arguments to specify the conditions for which the results
will be uploaded.

Once this parameter is set, all projects on the site can use the parameter when running UFT tests.

This feature is supported for ALM version 12.00.

Learn more: See the HP Application Lifecycle Management Administrator Guide for details
on the site parameters and its arguments.

New Features in UFT 11.50 Service Packs

Learn about the new features that were added to UFT since version 11.50.

New Features in the UFT 11.50 Service Packs: General

UFT now includes the following new features, which are relevant for GUI and API testing:

New UFT Look and Feel for BPT

UFT provides Business Process Testing from within UFT, using the native UFT user interface.
This enables users to create, maintain, debug, and run BPT tests together with GUI and API tests,
providing a single, one-stop-shop product for seamless functional testing.
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Business process tests and flows are comprised of business components, which can be used to
test specific parts of your application modularly. Business components include keyword GUI
components, scripted GUI components, and API components.

If you are familiar with using BPT in ALM, you can use BPT in UFT as follows:

e Add components and flows to your tests and flows by dragging them from the Toolbox pane to
the test or flow opened in the document pane.

¢ Manage component iterations in the Data pane.

e Link and promote parameters in the Component Parameters tab of the Properties pane. Use the
other Properties pane tabs to view and modify various test, flow, component, or group details,
such as descriptions, fields, and comments.

e Set parameter promotion options in the BPT Testing tab of the Options dialog box.

Note: The BPT canvas view is no longer available for BPT and Flow test types when editing
them in UFT.

Run Both GUI and API Tests using Virtualized Services

Using UFT, you can now run GUI tests as well as API tests that use a virtualized service. This
enables you to run tests of your application using a service that would otherwise be inaccessible for
test runs.

Using Service Virtualization, you design your virtualized service. Then, using UFT, you deploy the
virtualized service on a Service Virtualization server. When the test runs, the application accesses
the virtual service instead of the real service.

In addition, you can specify performance models for your virtualized service as well as different
data models. In this manner, you can vary the responses and performance of your application and
service to check its performance in a variety of different scenarios.

New Features in the UFT 11.50 Service Packs: GUI
Testing

UFT now includes the following new features, which are relevant for GUI testing:

ALM AUT Parameters - Now for GUI Tests Too

If you work with server-side execution using ALM Lab Management, you can now take advantage
of the option to link the parameters of your GUI test to ALM AUT Environment parameters. The
AUT Environment parameters are then used when running the tests using server-side execution.

In previous versions of UFT, AUT parameters were supported only for API tests.

What is server-side execution?
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In server-side execution, you run tests on remote host machines at predefined times or on an ad-
hoc basis, not requiring anyone to be logged in to the host to initiate and control the test runs.

Pass Complex Values from SAP Solution Manager to UFT
Tests
When you work in integrated mode with SAP Solution Manager, you can use structure-type test

parameters to pass complex values such as XML values or arrays from a Solution Manager test
script to a GUI test, or vice versa.

You create and maintain the structured parameters in SAP Solution Manager. Then you can map
action parameters to the structured parameters in your test. When you run your test, UFT receives
parameter values from SAP Solution Manager; and resolves the mapped local parameter with the
actual value from SAP Solution Manager.

The UFT automation object model also supports the new structure value type for test and action
parameters.

Improved Support for SAP NWBC-Web Objects

The UFT Add-in for SAP Solutions now supports SAP NetWeaver Business Client navigation
objects.

New Features in the UFT 11.50 Service Packs: API
Testing

UFT now includes the following new features, which are relevant for API testing:

Import a Web Application Description Language (WADL)
for API Tests

If you want to run an API test of a Web Application, you can now import WADL documents with
their hierarchy of services, resources and methods into an API test. UFT creates a hierarchy of
resources and methods (similar to a REST service) based on the details of your WADL. Using
UFT's REST service editor, you can enter the URL properties and other custom input or output
properties to create a more extensive API test of your application.

Creating Web Service Activities by Importing a Network
Capture into an API Test
Using a network capture file (compiled using a network capture program), you can create Web
Service, HTTP Request, or SOAP Request steps in your API test. UFT reads the TCP information

in your network capture file and creates a Web Service activity corresponding to the information in
the file.
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Using the network capture enables you to record the network traffic that your Web service performs
instead of manually creating the activity and its properties in your test. You can reimport the
network capture file each time you need the particular Web service activity in your test, making it
simpler to create and maintain your test.
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Product Enhancements

Learn about the product enhancements that have been added to UFT:

Product Enhancements in UFT 12.00 ... L 9
Run Flex Tests on Multiple UFT Instances Simultaneously (Windows Sever) ................ 9
Connect to ALM Using External Authentication (e.g. CAC) ... ... ... ... ..... 9

Enable or Disable Test Runs to Stop at Breakpoints During an ALM or Automation Run ... 10

See Details of Your Test's Virtualized Services inthe RunResults ........................... 10
Find Help More Easily ... .. 10
Use UFT's Testing Extensibility with Newer Visual Studio Versions __........................ 11
Product Enhancements in UFT 11.50 Service Packs ... . ... ... 12
Product Enhancements in the UFT 11.50 Service Packs: General ............................ 12
Product Enhancements in the UFT 11.50 Service Packs: GUI Testing ....................... 14
Product Enhancements in the UFT 11.50 Service Packs: APl Testing ........................ 22

Product Enhancements in UFT 12.00

Learn about the product enhancements that were added to UFT in version 12.00.

Run Flex Tests on Multiple UFT Instances
Simultaneously (Windows Sever)

To communicate with the Flex application it is testing, UFT now selects an available port in the
range 24654 - 24663 .

This enables multiple Windows Server users to run UFT tests on Flex applications simultaneously
without competing for use of the same port.

Connect to ALM Using External Authentication (e.g.
CACQ)

UFT can now use external authentication to connect to an ALM 12.00 server and project, instead of
using the traditional model of entering the user name and password in the ALM Connection dialog
box.

This enables users to use their installed external authentication certificates or single sign-on
mechanisms instead of maintaining and remembering a separate user name and password for their
ALM projects.
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If the ALM 12.00 server is configured to use an External Authentication system, such as CAC
(Common Access Card) or SiteMinder, then UFT uses this authentication method when you open
the ALM Connection dialog box.

Enable or Disable Test Runs to Stop at Breakpoints
During an ALM or Automation Run

A new RunDebug method is available in the Automation Object Model.

This method instructs UFT to stop at breakpoints when running a test using automation, whether
from ALM or in an automation run.

Note: If you use the already-existing Run Automation method, your tests do not stop at any
breakpoints saved in the test.

See Details of Your Test's Virtualized Services in the
Run Results

When you run a test that uses a virtualized service, you can now view the service's details in the
run results:

e The name of the service and location of the deployed service
o Deployment status of the service
¢ The performance and data models used in this test run-time agent mode

e The data simulation and performance simulation accuracy for the virtualized service in this test
run.

Find Help More Easily
You can now find relevant and meaningful information in the UFT Help more easily:

o Improved Help for API testing. The API Testing Design section now includes a chapter about
writing code that you can use in event handlers in API testing. This chapter also includes a list of
common objects and properties that you can use in an API test event handler.

« Improved search in function references

= Smaller GUI Testing Object Model Reference. The Help now contains a single copy of the
Help pages for Methods and Properties shared by all test objects in UFT. This change
substantially reduces the size of the Help, thereby improving search and index performance.

HP Unified Functional Testing (12.00) Page 10 of 28



What's New
Product Enhancements

In the Contents pane of the Help, these pages are displayed only under a Common Methods
and Properties node, parallel to the other Add-in nodes.

= Some Help functionalities that were missing since the reference format was changed from
CHM to Web Help are now restored.

© You can now use the Index to search for information in the GUI Testing Object Model
Reference and the VBScript reference.

o Context sensitive Help for VBScript keywords now opens the relevant topics.

¢ Unified customizable help for creating checkpoints and output values. In the single task
for creating checkpoint or output values, select the type of checkpoint or output value you want
to create and the relevant information is generated on-the-fly, containing only the details you
need.

o Easier to locate the Automation and Schema Reference CHM Files. The reference CHM
files that were previously accessible only from the Help menu (HP UFT GUI Testing
Advanced References Help) can now be reached from the Main UFT Help page.

This includes:

= UFT Automation Object Model Reference
= Object Repository Automation Reference
= HP Run Results Schema Reference

= Test Object Schema Reference

= Object Repository Schema Reference

Use UFT's Testing Extensibility with Newer Visual
Studio Versions
o Testing Extensibility now supports Visual Studio 2010 and Visual Studio 2012.
The sample applications have been updated:

= The Visual Studio 2003 samples were removed.

= New Visual Studio 2010 and Visual Studio 2012 versions of the Quickld and HoursReport
samples are available.

e The new Testing Extensibility SDK includes new interfaces that enable you to:
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= Add unrecorded steps to the test during a recording session.

= Add lines to a report during a run session. The report can be generic, or associated with a test
object.

= Provide an image file for an active screen, instead of a rectangle.

CQB Learn more: UFT Testing Extensibility is provided as an independent SDK. If you are
interested in Testing Extensibility, contact your HP provider.

Product Enhancements in UFT 11.50 Service Packs

Learn about the product enhancements that were added to UFT since version 11.50.

Product Enhancements in the UFT 11.50 Service Packs:
General

UFT now includes the following feature enhancements, which are relevant for both GUI and API
testing:

Use the Run Results Deletion Tool Directly from the Run
Results Viewer

The Run Results Deletion tool is now incorporated into the Run Results Viewer. This enables you
to automatically delete test results from tests and business process tests stored on ALM without
needing to independently connect the Run Results Deletion tool to ALM.

Where are the Remote Agent Log Settings?

The log setting options previously included in the ALM Remote Agent Settings dialog box were
designed primarily to enable HP support engineers to generate logs during support calls. They are
not needed for regular use.

These options have been removed from the dialog box.

More Detailed Reporting Options in the UFT Self Check
Tool

You can use the UFT Self Check Tool to see additional installation and configuration data for your
UFT installation, including:
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¢ Browser details

o UFT installation details

e UFT Add-in installation details
e UFT configuration settings

¢ SAP GUIl installation details

UFT tool dependencies information

Stop Your Run Session Using a Shortcut Key

You can define a shortcut key or key combination that stops the current recording session (for GUI
tests only) or run operation, even if UFT is not in focus or is in hidden mode.

In the Run Sessions pane in the Options dialog box (Tools > Options > General pane > Run
Sessions node, click in the Stop command shortcut key field and then press the required key or
key combination on the keyboard.

The default key combination is CTRL+ALT+F5.

Note: It is important to define a shortcut that is not already defined for some other operation by
the application being tested. If this is the case and:

e you open the application manually before you click Record or Run, the shortcut defined in
the application is applied for its original purpose.

e you start arecord or run session and UFT opens the application for you, the shortcut you
define stops the session.

New, Web-Based Help

UFT Help is now provided in a more modem, Web-based format that matches the look and feel of
the Help in your other HP products.

The following improvements have been added:

e This Help includes the product user guides, tutorials, and the Object Model Reference.
¢ You can find additional UFT reference material, such as the UFT and Object Repository
Automation references and the various XML Schema Helps in the UFT Advanced References

Help, available from the UFT Help menu.

¢ Instead of searching the thousands of topics included in the UFT Help, you can now use search
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filters to narrow your search. In the Search pane of your Help window, before you click the
Search button, you can narrow your search by selecting one of the following guides from the
Search filter:

= HP Unified Functional Testing User Guide - For searches about general UFT features and
functionality.

= HP Unified Functional Testing Add-ins Guide - When you need information about issues
related to a specific testing environment.

s HP Run Results Viewer User Guide- For details about the Run Results Viewer interface and
features or the information provided in the results.

= UFT Tutorial for GUI Testing - When seeking step-by-step instructions or examples on how
to use basic GUI testing functionality

»  UFT Tutorial for API Testing - When seeking step-by-step instructions or examples on how to
use basic GUI testing functionality

Using these filters, you can speed up your searches and more easily select the topic you need.

e The VBScript Help has been integrated into the UFT Web-Based Help. Previously, the Microsoft
VBScript Help was provided as part of the Advanced References CHM Help, separate from the
main UFT Web-based Help. This means that your searches in the UFT Help will include results
(when relevant) from the Microsoft VBScript Help. And when you press F1 on a standard
Microsoft VBScript function, the Help for that function will open in the main UFT Help, enabling
you to jump from that topic to other UFT Help topics.

Product Enhancements in the UFT 11.50 Service Packs:
GUI Testing

UFT now includes the following feature enhancements, which are relevant for GUI testing:

Continue Running GUI Tests on a Remote Computer
After Disconnecting

When working with an RDP connection, UFT can continue running GUI tests or (GUI-based)
business process tests on a remote computer after you disconnect your local computer from it.
Use this option to free up resources on your local computer so you can increase your overall
productivity, or so you can close your computer and go home for the day, while UFT continues to
run your test.

To enable this, configure the Allow UFT to continue running GUI or business process tests
after disconnecting from an RDP computer option in the Run Sessions pane of the Options
dialog box.

HP Unified Functional Testing (12.00) Page 14 of 28



What's New
Product Enhancements

Simplified Test Parameter Management

The Parameters pane of the Test Settings dialog box, in which GUI Test parameters were managed
in previous versions of UFT and QuickTest, has been removed.

You now perform all test parameter creation and maintenance operations for both GUI and
API tests from the Parameters tab of the UFT Properties pane.

Simplified Configuration for Flex Applications

In previous versions of UFT, if you wanted to test Flex applications, you needed to first compile
them specifically for testing.

UFT includes the UFT Flex Runtime Loader, which you can use to open most of your Flex
applications for testing, without having to pre-compile the application.

You can use the new Flex tab in the Record and Run Settings dialog box to instruct UFT to open
Flex applications at the beginning of a record or run session. In this tab, you specify whether you
have prepared the application in advance for testing, or whether UFT should open the application
using the Runtime Loader.

You can also configure the new Flex Record and Run settings using an automation script.

New Flex Test Object Methods and Properties

In addition to the Flex test object support that was introduced in 11.50, new test object methods and
properties were added in UFT:

Test Object New Methods New Identification Properties
FlexDropDownButton Close, Open

FlexProgressBar maximum, minimum, text, value
FlexSlider Set maximum, minimum, value

FlexSpin Next, Prev, Set maximum, minimum, step_size, value
FlexToggleButton Set state

Specify Areas to Ignore in an Insight Test Object Image

When using Insight to recognize objects, UFT searches for objects on your screen that match a
stored test object image.

When modifying a test object's image, you can now specify areas within the image that UFT
ignores when searching for a match. This is useful if parts of an object do not always look the same.
For example, if different icons are used on different operating systems to run a certain application.
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Additional Support for HTML5 Objects

The UFT Web Add-in now supports the following additional objects for HTML5 object recognition:

¢ WebAudio. Supports recognition of HTML audio objects.
e WebVideo. Supports recognition of HTMLS5 video objects.

o WebNumber. Supports recognition of HTML5 number objects. These objects may look like
numeric edit boxes or up-down spin controls, depending on the browser.

¢ WebRange. Supports recognition of HTML5 range objects.

Pass Output Parameters from a Called API Test Back to
the Calling GUI Test

Previously, when calling an API test from a GUI test, you could view and set the run-time value
only for the API test input parameters.

However, using the new RunAPITest method, you are able to see and use the output parameter
and value of the output parameter from an API test in later steps of a GUI test. Thus, if the service
(API) layer of your application returns a value that your application's GUI then uses, you can easily
and accurately test this instead of having to write complex functions to extract the information from
the API test output.

Make Your ALM or Network-Based GUI Tests into
Portable Tests

The popular Save with Resources feature from QuickTest is now also available for GUI Tests in
UFT.

It comes in handy if you need to open or run a test when you do not have access to a network drive
or ALM. For example, you may need to create a portable copy of a test for use when traveling to
other sites. Using the File > Save (Other) > Save with Resources command, you can save
everything you need to a local drive or to another storage device .

When you use this option, UFT creates a copy of the test, its resource, and any external actions
called by your test, and adjust the references from your test to the resources and external actions
so that you can use them locally.

Create 64-Bit COM Object References

Standard VBScript provides the CreateObject function, which enables creating 32-bit COM object
references. UFT has added the CreateObject64 statement, enabling you to create 64-bit
COM object references.
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Action Templates and External Properties are Back

The Action template and External Action Properties tab, which were available in QuickTest 11.00,
but not yet available in UFT 11.50, are now available in UFT.

Action Templates

You may want to create an action template when you want to add the same element to each new
action you create, such as the same comment, or the same ExecuteFile statement.

To create a new action template, create a text file containing all of the elements that you want to
include in your template, and save it as ActionTemplate.mst, in the <UFT installation>\dat
folder. The ActionTemplate.mst file must have the same structure and format as an action in the
Editor.

External Action Properties

The External Action Properties tab enables you to specify the data source for the selected action. It
is available only when viewing properties for external actions.

The External Action tab provides the following options:

o Use data stored with the original action (read-only). Uses the original action's data. If you
select this option, the data is read-only when viewed from the calling test, and all changes to the
original action's data sheet apply when the action runs in the calling test.

e Use a local, editable copy. Uses an editable copy of the data in the test's data table. If you
select this option, a copy of the called action's data sheet is added to the calling test's data table
and is independent of the original action.

If the called action has parameterized steps that rely on new information in the original action's
data sheet, enter the relevant column names and required data to the action sheet in the calling
test manually.

Insert SAP Structured Parameters in Your Test Using
Statement Completion

In UFT, you can map action parameters in you test to structured parameters defined in SAP
Solution Manager.

Now, UFT's statement completion helps you use these structured parameters in your test by
displaying the elements available in the structure.

If you type the name of a structured action parameter in a test step, followed by a colon (;), UFT
displays the structure's elements. If you type a structured parameter element, followed by a period
(.), UFT displays the relevant sub-elements.
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Add ClickSpecial for InsightObject

The InsightObject.Click method brings the Insight object’s parent test object into focus before
performing the click.

In some cases, this change of focus may hide your Insight object in the application, making it
impossible for UFT to find and click it. In those cases, you can use the new

InsightObject.ClickSpecial method, which does not bring the parent test object into focus before
clicking.

Work with . XLSX-Format Excel Files

UFT now fully supports the .xlsx format of Excel files for importing data to the Data Table or when
specifying an Excel file for use with ALM configurations.

Use the Errors Pane to Detect Unmapped Repository
Parameters

When your test contains an unmapped repository parameter, the Errors pane displays the test
name and path in the ltem column.

Add-in Enhancements for Web, Dojo, and SAP

Web Add-in
Style/* Notation

You can now use the new Style/* notation to access the values of HTML5 CSS properties of Web-
based objects.

For example, you could use the following programmatic description to identify all edit boxes on a
page that had a red background color:

Set oDesc = Description.Create()

oDesc("micclass").Value = "WebEdit"

oDesc("style/background-color").Value = "rgb\(255, 0, 0\)"
New Supported HTML 5 Identification Properties for WebEdit

e pattern. The regular expression pattern defined for the edit box, which controls which values
that the edit box will accept.

o placeholder. The hint text that is displayed in the edit box until a value is entered in it.

¢ required. Indicates whether the edit box must be populated before the form is submitted.
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Mozilla Firefox only: A new method, DialogExists, is available for Browser test objects. The
DialogExists method checks whether a dialog box is currently open in the browser. This can be
useful before using the Browser.HandleDialog or Browser.GetDialogText methods.

Flex Addin
e UFT can recognize a Flex application that is opened by specifying the URL of the SWF file in an

Internet Explorer address bar. There is no need to create a simple HTML wrapper file to test
such a SWF file (as was required in UFT 11.50).

e UFT canrecognize Flex test objects in windowless Flex applications, when the root
FlexWindow object is manually added to the object repository.

The Navigate and Learn option is not supported for windowless Flex applications .

Dojo Add-in

You can now test the behavior of Dojo calendar controls in your Dojo 1.8 applications.

Web 2.0 toolkit files are not updated with the Service Pack 2 installation. To update Web 2.0
toolkits, which now include support for Dojo version 1.8, run the Web2AddinSetup. exe file after
installing UFT Service Pack 2. The Web2AddinSetup.exe file is located in the <UFT
installation folder>\DVD\Extensibility and Toolkits\Web2AddinSetup folder.

SAP Add-in

UFT provides new support for the following SAP Web Dynpro ABAP controls (grouped by the test
object that represents each control):

Link

e BreadCrumb

FileDownload

LinkChoice

Link ToAction

ToggleLink

ToolBarLinkChoice

SAPButton

e Button

e ButtonChoice

HP Unified Functional Testing (12.00) Page 19 of 28



What's New
Product Enhancements

e ButtonRow

e FormattedTextEdit

e HorizontalContextualPanel

e |conButton

e LinkToAction

e LinkToUrl

e TextView

ToggleButton

SAPCheckBox

e CheckBox
e CheckBoxGroup

e TriStateCheckBox

SAPCalendar

e DateNavigator

SAPDropDownMenu

e LinkChoice

ToolBarLinkChoice

SAPEdit

e |nputField

SAPiView

o Tray

SAPList

e DropDownBylndex

e DropDownByKey
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SAPNavigationBar

o ContextualPanel

¢ NavigationList

SAPRadioGroup

o RadioButton
¢ RadioButtonGroupBylIndex
¢ RadioButtonGroupByKey

SAPTable

e Table

SAPTabStrip

e HorizontalContextualPanel
¢ PanelStack

e TabStrip

SAPTreeView

e Tree

Image

e Legend
Link
e LinkToUrl

e Shuttle

WebButton

e Tray

WebEdit

¢ FormattedTextEdit
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WebElement

Caption

Explanation

¢ FormattedTextView
o Label

e Legend

¢ MessageArea

o PageHeader

e Phaselndicator

¢ RoadMap

e SectionHeader

WebFile

e FileUpload

WebTable

o Explanation

e MultiPane

Performance has also been improved for recording steps on SAP Web controls. In addition, some
errors related to failures in identifying certain SAP Web objects during a run session no longer

occur, These errors caused steps on those objects to fail and UFT reported that the test object
description was not unique or that the object was not found.

Product Enhancements in the UFT 11.50 Service Packs:
APl Testing

UFT now includes the following feature enhancements, which are relevant for API testing:

Enhanced Usability Features for REST Testing ......... ..., 23
Configuring Security for SOAP 1.2 . 23
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Enhanced Usability Features for REST Testing

A number of new features have been added to improve your ability to edit and use REST services in
your test:

e REST Services as a single activity instead of a composite activity. In previous versions of
UFT, after adding a REST service method to the canvas, the method was displayed as a
composite activity, with an HTTP Request step contained within the REST method. This
required you to configure the HTTP properties for the method separately from the REST method
properties. Furthermore, if you needed to use the HTTP property values for the REST method,
you were required to expose these properties to the method step.

In this version, newly inserted REST methods are displayed as single activities and there is no
need to separately configure the HTTP properties in a separate HTTP request step. The

HTTP and URL properties are contained within the REST activity, making it simpler to set the
REST method properties at one time.

(Any REST methods you inserted to your tests in previous versions will still be included as
composite activities.)

e Passing of REST Service properties throughout the REST hierarchy. In previous versions,
you were required to set the URL property values and other custom input or output properties for
a REST service for every method contained in a REST service, even if the properties were
exactly the same.

In this version, using the REST service editor, you can set a URL property value or other custom
input or output properties at a particular level of the REST Service hierarchy, and these values
and properties are passed to all resources and methods contained under that service or
resource. This makes it much more efficient to create and edit your REST services which use
common repeated properties.

e Loading HTTP Requests in XML as text. In previous versions, if your HTTP requests for
REST methods were in XML format, you were required to load the XML file into the REST
service. Now, you can load the XML text directly into the Request and Response fields in the
REST services editor, instead of requiring a separate external file.

Note: This enhancement is also relevant for HTTP activities.

Configuring Security for SOAP 1.2

You can now configure security for SOAP version 1.2.
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New Supported Operating Systems and
Environments

This section lists the operating systems, browsers, and development environments that are newly
supported in the UFT service packs. For details, see:

New Supported Operating Systems and Environments: General

New Supported Environments for GUI Testing

The topics in this section detail only newly supported environments. For a complete list of all
supported environments, see the Product Availability Matrix, accessible from the from the UFT help
folder (<Unified Functional Testing installation folder>\help): UFT_PAM. pdf

New Supported Operating Systems and
Environments: General

New in UFT 12.00

Environment Versions/Details

Operating Systems Windows 8.1 (Technology Preview level)
.NET Framework Version 4.5
Testing Extensibility Support for Visual Studio 2010 and 2012
New in the UFT 11.50 Service Packs

Environment Versions/Details

Operating Systems o Windows 2012 (full support)

e Windows 8 (full support)

Virtualization Environment Citrix 6.5

New Supported Environments for GUI Testing

New in UFT 12.00
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Environment Versions/Details
Web ¢ Internet Explorer 11
e Updated Mozilla Firefox and Chrome support. For details on

specific browser versions, see the HP Unified Functional
Testing Product Availability Matrix.

o Safari on Mac (Technology Preview level): 6.00 and 6.10 (on
Mac OS Mountain Lion 10.8) and 7.00 (on Mac OS Mavericks

10.9)
Delphi Delphi XE2
Stingray Stingray 11.1
SAP Web Dynprop ABAP for NW 7.31

New in the UFT 11.50 Service Packs

Environment Versions/Details

Web e Mozilla Firefox 16, 17, 18, 19, 20, 22, 23, and 24

Internet Explorer 10 in Windows 7

¢ Interet Explorer 10 over Windows 8 (Technology Preview
level)

e 64-bit Java applets in Internet Explorer 64-bit editions
e D0jo1.8

Flex e Apache Flex SDK 4.6
e Apache Flex SDK 4.9

.NET Framework 4.5 Supported for the .NET, Silverlight, and WPF add-ins

PeopleSoft e 9.53
e PeopleSoft PeopleTools 8.52

Oracle Oracle Forms/Report 11gR2
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Environment Versions/Details

SAP o NWBC (Netweaver Business Client) for HTML 3.5

SAP Netweaver Portal 7.3

SAP CRM 7.0.2

SAP CRM7

New SAP Web Dynpro ABAP 7.01 and 7.02 Controls

Siebel Siebel 8.2.2

Terminal Emulators e HP TeemTalk 7.2
¢ Rocket BlueZone 6.x

Note: The Web Services Add-in that was provided with QuickTest is not included in UFT.
Instead, use the UFT API testing features to test your Web Services.

If you need to work with your existing QuickTest Web Services Add-in assets in UFT, contact
HP Software Support or your HP Software provider.
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We appreciate your feedback!

If you have comments about this document, you can contact the documentation team by email. If
an email client is configured on this system, click the link above and an email window opens with
the following information in the subject line:

Feedback on What's New (Unified Functional Testing 12.00)
Just add your feedback to the email and click send.

If no email client is available, copy the information above to a new message in a web mail client,
and send your feedback to sw-doc@hp.com.
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